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Examples of Software Engineering Debt
(just some of the most common LabVIEW development mistakes)

� No source code control (or Project)

� Flat file hierarchy

� ‘Stop’ isn’t tested regularly

� Wait until the ‘end’ of a project to build an application

� Few specifications / documentation / requirements
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� Few specifications / documentation / requirements

� No ‘buddying’ or code reviews

� Poor planning (Lack of consideration for SMoRES)

� No test plans

� Poor error handling

� No consistent style

� Tight coupling, poor cohesion



The Cost of a Software Defect

Development Phase Cost Ratio

Requirements 1

Design 3-6x

Implementation 10x
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Implementation 10x

Development Testing 15-40x

Acceptance Testing 30-70x

Post Release 40-1000x

Based on an analysis of 63 software development projects at companies including IBM, GTE and TRW



A Highly Productive Graphical Development Environment for Scientists and Engineers
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Programming Approaches

Analysis Libraries

Deployment Targets

Hardware APIs Custom User Interfaces

Technology Abstractions



Lawrence Livermore National Labs
Developed automated maintenance process for world’s most energetic laser array 

at the National Ignition Facility using NI LabVIEW and PXI

• LabVIEW increased productivity by 3X over Java and C++

• Developed complex application consisting of over 1,000 VIs

• Applied software engineering practices to ensure quality

“The value in using the 
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“The value in using the 

graphical dataflow 

language is the speed in 

which a team can deliver a 

robust solution while still 

using proper software 

engineering practices.

- Glenn Larkin, LLNL

An overhead view of one of the main laser chambers



LabVIEW in Large Applications

High-Volume Production Test Structural Health at Olympics Medical Devices
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In-Flight Fire SuppressionNexans Spider Robot Large Physics Applications

High-Volume Production Test Structural Health at Olympics Medical Devices



Requirements 
Gathering

Application 
Architecture

Deployment

Integration 
Testing

Review and Test

Software Engineering V-Model

Prototyping Service
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Development 
& Debugging

Unit Testing
Module 

Architecture



Seminar Topics

• Configuration Management and Code Reuse

• Requirements Management and Traceability

• Peer Reviews and Code Analysis 

• Testing and Verification of Software

• Object-Oriented Design Patterns
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• Object-Oriented Design Patterns

• Hardware Abstraction Layers

• Data Communication Approaches

• Error Handling

• Advanced User Interface Design

ni.com/largeapps
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DEMO

Application Introductions



Configuration Management and Code Reuse
Section One
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Size of LabVIEW Applications
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0 to 100 VIs 100 to 250 VIs 250 to 1000 VIs 1000 to 3000 
VIs

3000 to 5000 
VIs

Greater than 
5000

Source: 2010 ni.com/largeapps survey



Average Number of Developers Per Project

15
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25

13

0

5

10

> 10 5 to 10 3 to 5 2 1

Source: NIWeek 2008 Software Engineering Survey 



The Project Explorer

Benefits

• Easily access and navigate files

• Preserve links when moving files

• Manage hardware targets

• Detect and find dependencies
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• Detect and find dependencies

• Prevent and auto-detect cross-linking

• Integration with Application Builder

• Access to source code control



Managing Files

Autopopulating Folders

Virtual Folders

are synchronized to disk. They 
update in real time to reflect the 
contents of folders on disk.
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Virtual Folders
allow you to customize how and 
where files are displayed. They 
provide a ‘snapshot’ view if 
added from disk



Managing Dependencies
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DEMO

Moving an Application into the Project Explorer



Project Explorer Recommendations

• Use virtual folders by default

• Use virtual folders to contain any .lvlib-like object

• Use auto-populating folders for components that you 
want to automatically bring into the project.  
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want to automatically bring into the project.  
(examples: log-files, pictures, plugins, test results)

• Check the dependencies section often 

• Move project items from within the Files tab

• Break-up large applications into multiple projects



Requirements 
Gathering

Application 
Architecture

Development Validation Deployment

Software Configuration Management Tools

Source Code Control
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� Provides repository of code

� Store multiple versions and branches

� Easily track changes

� Manage a team of developers

� Reduces pain throughout process



Tracking Changes to Source Code

• A change to the code causes a problem that isn’t detected for 
several revisions

• How can you track changes over time to identify when the 
behavior changed?

What changed?
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bug introduced

Code Revision

bug detected
What changed?

Change corrected



Group Development

• Two developers, Joe and Jack, are working together

• Jack copies (a.k.a. ‘branches’) Joe’s code

• Joe and Jack are making changes to the same application

• How do they track changes to shared dependencies and 
expedite the process of merging their work?
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Joe’s Code

Jack’s Code

Merger

Code Revision

expedite the process of merging their work?



Source Code Control

Developer 1
Merger

Code Revision

Locked for edit

Requirements 
Gathering

Application 
Architecture

Development
Debugging & 

Testing
Deployment

Software Configuration Management
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Developer 2

Code 

Repository

Checked Out Checked In

Checked Out Checked In

Checked InChecked Out

Get Latest Version



Graphical Differencing
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•Provides a checklist of changes
•Useful for peer reviews
•Available via command-line



SCC Options for Integration within LabVIEW 

Native LabVIEW Integration
• Perforce

Integration Through Standard API
• Microsoft Visual SourceSafe 
• Microsoft Team System 
• Rational ClearCase
• PCVS (Serena) Version Manager 
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• PCVS (Serena) Version Manager 
• MKS Source Integrity 
• Seapine Surround SCM 
• Borland StarTeam
• Telelogic Synergy 
• ionForge Evolution

Support through additional add-ons
• Subversion
• Mecurial



Popularity of SCC Options Amongst LabVIEW Programmers

48
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Perforce Subversion ClearCase Git VSS Mecurial none

Source: 2010 ni.com/largeapps survey
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DEMO

Configuration Management



Development Trunk
Feature-Team
Repository

Feature-Team
Repository

Feature-Team

NI Configuration Management

• Different trunk for each 
LabVIEW version

• Teams of 3 to 7 
developers work in 
smaller repositories
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Feature-Team
Repository

Individual’s Local
Repositories

smaller repositories

• Individuals may have 
their own repositories

• New features and 
changes are regularly 
merged in



Separate Compiled Code From Source File
Improved Source Code Control Integration

2009
.vi file format

2010
.vi file format*

Front Panel
Block 

Diagram

Connector 

Front Panel
Block 

Diagram

Connector 
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Eliminate the need to re-save and re-submit files to source code control unless 

the graphical source code has been changed by the developer

*this feature is not on by default and needs to be enabled from the VI Properties dialog

Connector 

Pane
Icon

Compiled 

Code

Inplaceness

Info

Compiled 

Code

Inplaceness

Info

Connector 

Pane
Icon

A separate object file is created to 
store and retain this information



TopLevel.vi

Source Code Control Scenario: Today

In SCC

TopLevel.vi

Local Machine

Edit

SubVI2.vi

SubVI1.vi

SubVI2.vi

Edit

Save

Check-in

SubVI1.viSubVI1.vi SubVI1.vi



Source Code Control Scenario: 2010

In SCC

TopLevel.vi

Local Machine

Edit

local .viobj

cacheTopLevel.vi

SubVI2.vi

Edit

Run/SaveSubVI1.vi

Check-in

TopLevel

.viobj

SubVI1

.viobj

SubVI2

.viobj

TopLevel

.viobj

SubVI1

.viobj

SubVI1.vi

SubVI2.vi

SubVI1.viSub VI1.vi SubVI1.vi



The Project Library

• Provide name-spacing to 
avoid cross-links

• Organize sections of an 
application into components

• Modify contents without 
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• Modify contents without 
modifying the Project file

• Pack them into a single, non-
editable file



Project Libraries (.lvlib)

Xcontrols (.xctl) Classes (.lvclass)
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lvlib
Project Library

VI VI CallersVI

VI VI VI VI Public API

VI VI CallersVI

Packed Project Library

Deployed SystemDevelopment Environment

Packed Project Libraries New in LabVIEW 2010
Distribute and Deploy LabVIEW Libraries as a Single File
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VI VI VI VI Public API

Private VIs

VI VI VI VI Public API

Compiled 
code

• Decrease build times

• Deploy the VI hierarchy with a single file

• Simplified code deployment



VI Package Manager
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Build and manage packages of LabVIEW code



Structured Error Handler

Install and Manage VI Packages
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GXML Library
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DEMO

Introduction to the VI Package Manager



Easily Upgrade and Downgrade Versions
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Create VI Configuration Files

A single file that contains multiple packages.  

Easily share and distribute code that depends upon multiple libraries. 
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Structured Error Handler

GXML Library AMC Library G Library

Structured Error 
Handler Config
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Create a Configuration File by Scanning a Project



Track Changes Integrate with SCCSystem Level View

Software Configuration Management for LabVIEW
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Manage Reuse LibrariesMerge Graphical Code Manage Files and Links

Software Configuration Management for LabVIEW



Software Development Best Practices
Section Two
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Software Development Risk Continues to Rise
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1. Deliver a working product
2. Prove it works right
3. Mitigate risk of failure
4. Avoid last-minute changes

Goals

Ensuring Software Quality and Reliability
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1. More complex software
2. Mission-critical applications
3. Team size is growing
4. Increased scrutiny
5. Decreased time

Why?



Have the software requirements been implemented? 

We did what we were supposed to.

Have the test cases been implemented?

We tested what we were supposed to.

Has the code passed the functional tests? 

Certifying an Application

Software 
Requirements

Unit 
Requirements 

Unit Test 
Requirements

Has the code passed the functional tests? 

The implementation is correct.

Have the tests exercised the required percentage of 

code? Code has been sufficiently covered in testing.

Has the code passed static analysis standards? 

The implementation is standard.

Graphical 
Code

Unit Test

HDL C



More Overhead - Less Time
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Mitigating Risk Through Hardware

H
a

rd
w

a
re

O
p

e
ra

tin
g

 S
y

ste
m

D
riv

e
r A

P
I

A
p

p
lica

tio
n

 S
o

ftw
a

re

C
a

lcu
la

tio
n

Traditional System Crash Possible
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LabVIEW FPGA System Highest Reliability

Mitigating Risk Through Hardware

47

H
a

rd
w

a
re

O
p

e
ra

tin
g

 S
y

ste
m

D
riv

e
r A

P
I

A
p

p
lica

tio
n

 S
o

ftw
a

re

C
a

lcu
la

tio
n

Patient

Outputs



The Software Engineering Process

NI Requirements 
Gateway

Requirements 
Gathering

Application 
Architecture

Development
Testing and 
Validation

Deployment

LabVIEW Unit 
Test Framework

Application 
Builder

LabVIEW 
Statechart

Dataflow
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Gateway

LabVIEW
VI Analyzer

LabVIEW Desktop 
Execution Trace

Test Framework BuilderStatechart

Improve quality. Reduce risk. Save time. 

Prove it works.

Object 
Orientation

Real Time

FPGA

Embedded
NI TestStand

User Interface 
Testing

MathScript

Statechart

Simulation



The Software Engineering Process

NI Requirements 
Gateway

Requirements 
Gathering

Application 
Architecture

Development
Testing and 
Validation

Deployment

LabVIEW Unit 
Test Framework

Application 
Builder

LabVIEW 
Statechart

Dataflow
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Gateway

LabVIEW
VI Analyzer

LabVIEW Desktop 
Execution Trace

Test Framework BuilderStatechart

Improve quality. Reduce risk. Save time. 

Prove it works.

Object 
Orientation

Real Time

FPGA

Embedded
NI TestStand

User Interface 
Testing

MathScript

Statechart

Simulation



Requirements Traceability Solution from NI
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Requirements 
Gathering

Application 
Architecture

Development
Debugging & 

Testing
Deployment
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Requirements Coverage and 

Project Tracking Traceability and Documentation

Generation
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DEMO

Requirements Tracking



Documentation

• Labeled objects

• In-line comments

• Distinct Icon
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• Distinct Icon

• Description and Tip

• HTML Print-Out

• Requirements Coverage



Tools for Debugging and Testing Debugging & 

Testing

Dynamic Code AnalysisReal Time 

Functional Validation 

of Code
Unit Test 
Framework
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High RiskLow Risk

Dynamic Code AnalysisReal Time 
Execution Trace

Static Code Analysis

S
im

p
leA
pp

lic
at
io
n 
C
om

pl
ex

ity

Application Criticality

Desktop 
Execution Trace

VI Analyzer 
Toolkit



Performing a LabVIEW Code Review

• Walk someone through your code

• Questions to consider:

� Is the code easy to maintain, and has it been documented?

� What happens if the code returns an error?

(… or if it receives an error?)
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(… or if it receives an error?)

� Is too much functionality located in a single VI?

� Are there any race conditions?

� Is the memory usage within acceptable limits?

• Perform code reviews frequently



Establish or Adopt Development Guidelines

Front Panel Style
� Fonts and Text Characteristics

� Colors 

� Graphics and Custom Controls

� Layout

� Sizing and Positioning

� Labels 

� Paths versus Strings

� Enumerated Type Controls versus Ring Controls 

Block Diagram Style
� Wiring Techniques 

� Memory and Speed Optimization

� Sizing and Positioning

� Left-to-Right Layouts 

� Block Diagram Comments 

� Call Library Function Nodes and Code Interface 
Nodes 

� Type Definitions

Sequence Structures
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� Default Values and Ranges 

� Property Nodes 

� Key Navigation

� Dialog Boxes 

Style Checklist 
� VI Checklist

� Front Panel Checklist 

� Block Diagram Checklist

� Sequence Structures

Icon and Connector Pane Style 
� Icons 

� Example of Intuitive Icons

� Connector Panes 

NI Style Guideline: ni.com/largeapps



Preparing for a Code Review with VI Analyzer

• Automate code analysis 
with 80+ configurable tests

� Performance

� Style 

Complexity
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� Complexity

• Interactively inspect failures

• Generate custom reports

• Code complexity metrics

• Write your own tests with VI 
Scripting LabVIEW 2010



VI Analyzer Code Complexity Metrics
Tests for Industry Standard Metric Calculations
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True

False

Case 1

Case 2

Case 3

Edges = 5   Nodes = 3   Paths = 1

Cyclomatic complexity: 5 – 3 + 2 (1) = 4



Creating Custom Tests

Select tests to run

Test specific 
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Test specific 
configuration 

settings

Test PriorityNumber of failures to 
report



Define Configuration Options
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Access values in test code using
Global variables
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DEMO

VI Analyzer for Peer Reviews



Tools for Debugging and Testing Debugging & 
Testing

Dynamic Code AnalysisReal Time 

Functional Validation 

of Code
Unit Test 
Framework
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High RiskLow Risk

Dynamic Code AnalysisReal Time 
Execution Trace

Static Code Analysis

S
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Application Criticality

Desktop 
Execution Trace

VI Analyzer 
Toolkit



Goals of Dynamic Code Analysis:

• What is consuming system memory?

• Am I capturing all the errors in my application?

• What was the last event to occur before…?

• What was the call-chain that led us to…?

• What thread is it executing in?

63

• What thread is it executing in?

• Am I actually entering a specific event-case?

• What happened inside a structure?

• What order to these events occur in?

• Is a daemon process running in the background?

• Does the code behave different in an executable?



Trace Production Systems Remotely

Run-Time Execution Information

Network

VIs and Debuggable Executables

LabVIEW Desktop Execution Trace Toolkit
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Run-Time Execution Information

Network

Deployed Real-Time Applications

LabVIEW Real-Time Execution Trace Toolkit



Desktop Execution Trace Toolkit

Trace During Run-Time:

• Event Structures

• Memory Allocation

• Queues / Notifiers

• Reference Leaks
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• Reference Leaks

• Thread ID

• Unhandled Errors

• Dynamic / Static SubVIs

• Custom User Strings



Desktop Execution Trace Toolkit

Trace During Run-Time:

• Event Structures

• Memory Allocation

• Queues / Notifiers

• Reference Leaks
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• Reference Leaks

• Thread ID

• Unhandled Errors

• Dynamic / Static SubVIs

• Custom User Strings
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DEMO

Dynamic Code Analysis with Desktop Execution Trace Toolkit



Remote Debugging of Executables

• Include block diagrams with an executable

• Remotely troubleshoot using LabVIEW debug tools
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Tools for Debugging and Testing Debugging & 
Testing

Dynamic Code AnalysisReal Time 

Functional Validation 

of Code
Unit Test 
Framework
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High RiskLow Risk

Dynamic Code AnalysisReal Time 
Execution Trace

Static Code Analysis
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Execution Trace

VI Analyzer 
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Data Science Automation

Developed Long-term testing solution for artificial hearts

"The Unit Test Framework’s 
flexibility and ease of use 
certainly enabled much faster 
and reliable completion of this 
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and reliable completion of this 
portion of the project 
potentially saving hundreds 
of hours and thousands of 

dollars over the life of the 
project."



LabVIEW Unit Test Framework

VI Under Test

Input Values Output
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Expected Output
Unit Test 

Framework
Automated

Report Generation

Test vector = Input value(s) + Expected output(s)



LabVIEW Unit Test Framework

VI Under Test

Input Values Output
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Windows Desktop

Expected Output
Unit Test 

Framework
Automated

Report Generation

Test vector = Input value(s) + Expected output(s)



LabVIEW Unit Test Framework

VI Under Test

Input Values Output
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Real Time

Expected Output
Unit Test 

Framework
Automated

Report Generation

Test vector = Input value(s) + Expected output(s)
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Unit Testing



Setup / Teardown VIs

Input

Values

Value

Comparison



Code Coverage Example

6 Diagrams. 3 Diagrams Executed. 50% Code Coverage

76

6 Diagrams. 3 Diagrams Executed. 50% Code Coverage



Code Coverage Example
1ST Test Vector:

Block diagram, 2 Case diagrams executed. ( 2 + 1 ) / 6 = 50% Code Coverage
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2nd Test Vector (aggregates covered code from 1st pass)

Block diagram, 5 Case diagrams executed. ( 4 + 1 ) / 6 = 83.33% Code Coverage



Programmatic Unit Testing

• Programmatically 
invoke testing and 
report generation
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Implementation

Software Requirements

Integration with Requirements Gateway
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Unit Tests

Test Results



LabVIEW User Interface Testing
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Application Builder API Coming in LabVIEW 2011
Automate build and deployment processes
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App Builder Log-File Generation
Document version, date and time of Vis included in build

Available in LabVIEW 2009
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Advanced Software Architectures and

Data Communication

Section Three

83

Data Communication



Why Should I Use One?

Definition: A well-established solution to a common problem.

What is a Design Pattern?
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Why Should I Use One?
Save time and improve the longevity and readability of your code.

… or else…



Designing for SMoRES
Criteria for a well designed software application:

Scalable: how simple is N + 1?

Modular: is the application broken up into well-

defined components that stand on their own?

Reusable: is the code de-coupled from the current 

application well-enough such that it could be 

85

application well-enough such that it could be 

reused in a future project?

Extensible: how painful is it to add new 

functionality?

Simple: what is the simplest solution that satisfies 

all of the listed criteria and the requirements of 

the application?



You Should Already Be Familiar With..

• Loops

• Shift Registers

• Case Structures

• Enumerated Constants

• Event Structures
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• Event Structures

• LabVIEW Classes



User Interface Considerations

Common Requirements

1. Highly-Responsive

2. Data appears to be 
streaming

3. Multiple interfaces
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3. Multiple interfaces

Considerations

1. Polling is inefficient

2. The screen has finite pixels



Event-Driven Loop

User Interfaces Should Be Responsive

Best Practices

1. Use an event structure

2. Do as little as you can in the event 
cases

3. Delegate actions to consumers

4. Defer panels updates for smooth 
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User Interface State Machine

4. Defer panels updates for smooth 
updates 

Considerations

1. How do you send commands?

2. How do you send data?

3. How fast do you really have to 
update the front panel?



Anatomy of a Producer Process

Process

Stop 
Condition 
Met?

Action or Event
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Send 
InformationData

Information

Sends message to other process, program, or target



Anatomy of a Message Producer Process

Process

Stop 
Condition 
Met?

Action or Event
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Inter-Process 
CommunicationData

Command

Sends message to other process, program, or target

Message comprised of a 

command and optional data



Constructing a Message

Examples

Data
Variant allows data-type to 

vary.  Different messages 

may require different data

Command
Enumerated constants 

list all of the options
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Examples
Command Data

Initialize UI Cluster containing configuration data

Populate Menu Array of strings to display in menu

Resize Display Array of integers [Width, Height]

Load Subpanel Reference of VI to Load

Insert Header String

Stop -
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Basic State Machine



Stop 
Condition 

Update 
Local Data

Anatomy of a Consumer Process

Execution

Get Local 
Data
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Condition 
Met?

Next 
Steps

Execution
‘Heavy Lifting’

Receive 
Information



Anatomy of a Message Consumer Process

FIRST STATE

Case structure has a case for every command

Command 

Data cluster for all states

After command is executed, 

data cluster may be updated
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?

Next 
Steps

Next steps could enqueue new action for 

any other loop, including this one

Optional data for 

specific command

Command 
Execution

Dequeue
Action & Data

Queue

Reference



FIRST STATE

Case structure has a case for every command

Data cluster for all states

After command is executed, 

data cluster may be updated

Command 

Anatomy of a Message Consumer Process
Also known as ‘Command Pattern’

Defines the scope of 

operations this 

consumer can 
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?

Next 
Steps

Next steps could enqueue new action for 

any other loop, including this one

Queue

Reference

Command 
Execution

State 
Specific 
Data-type 
Definition

Variant To Data

Dequeue
Action & Data

consumer can 

handle



FIRST STATE

Message Consumer Considerations 

Handling a new command requires 

modification of the top-level code
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?

Variant To Data

Consumer must know the data-type of 

variant and cast it correctly



Why Use Object-Orientation in LabVIEW?

• Encapsulate and protect data

• Catch errors at compile time instead of run-time

• Easily extend functionality

• Eliminate large data clusters
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• Eliminate large data clusters

• Implement established design patterns

• Map real-world problems to software



Understanding Object-Oriented Programming

Class: A collection of data and the methods 
that interact with that data.
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Object: A specific instance of a class



Examples of classes

Class: Car Person

Data:

Make
Model
Year

First Name
Last Name
Date of Birth
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Data: Year
Mileage

Date of Birth
Gender

Methods:
Check Brakes
Rotate Tires
Change Oil

Get Full Name
Get Age



Examples of objects

Class: Car Person
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Object:

•1964 Ford Mustang
•2004 Honda Accord

•Adam Kemp
•Steven Harrison



What Is a LabVIEW Class?

Class: A collection of data and the 
methods that interact with that data.

Object: A specific instance of a class
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A LabVIEW Class is…

• A glorified cluster

• A user-defined data type

• A type of Project Library



What Is Inheritance?

Example methods:

• Initialize

• Get Cargo Capacity
Vehicle Class

(Parent)
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Car Class
(Child)

Truck Class
(Child)

A truck is a type of vehicle.A car is a type of vehicle.



Inheritance Example 

Vehicle Class

Car Class Truck Class

Ancestors

Descendents
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Chevy Model 

2007 Model 2008 Model 



Understanding Dynamic Dispatch

2610
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Vehicle.lvclass

Get Cargo Capacity.vi

Truck.lvclass

Get Cargo Capacity.vi

Car.lvclass

Get Cargo Capacity.vi



State Machine vs. Command Pattern
These diagrams represent functionally equivalent code
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Traditional PC-QSM Approach



OO-Based State Machine Design

UI Command

sendCommand()
execute()

Initialize

execute()

LoadPanel

execute()

SlidePanel

execute()

Populate Menu

execute()

Also known as ‘Command Pattern’ or ‘Chain of Command Pattern’
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execute()

+ WriteUIParameters
+ ReadUIParameters

execute()
displayPlugin()

+ WriteVIReference
+ ReadVIReference

execute()
move()

execute()
displayPlugin()

+ WriteButtonNames
+ ReadButtonNames

Uses Dynamic Dispatching to determine (at run-time) which version of 
the execute method gets run



Command Class Hierarchy
Objects represent the commands to be executed

Data
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Command Data

Initialize UI Cluster containing configuration data

Populate Menu Array of strings to display in menu

Resize Display Array of integers [Width, Height]

Load Subpanel Reference of VI to Load

Insert Header String

Stop -



Dynamic Dispatching Commands
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Dynamic Dispatching Commands
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DEMO

Creating and Sending a New Command



The Basics of an Object Factory
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A
B

C
Generic Plugin

Location on Disk

Where Plugins are Stored

Objects Loaded Into Memory

A B C

���� Parent

���� Children



User Interface State Machine

Event-Driven Loop

Self Contained Application Framework

Plug-in State Machine
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Indefinite dynamically loaded plug-ins



Factory Design Pattern Example
Generic Plugin

Data

-UI Reference
-Plugin Name

Dynamic

Configure Plugin()
Run()
Stop()

Plugins are required to 

override configuration
Static

Register Events()
Read Events()
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Plugin A

Configure Plugin()

Plugin B Plugin C Plugin D

Configure Plugin()
Stop()

Configure Plugin()
Run()
Stop()

Configure Plugin()
Run()

Read Events()
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DEMO

Creating a Plugin



Event-Driven Loop

Self Contained Application Framework

Plugins Need To Receive Commands

We need to be able to send 
individual plugins a command
“You’re Being Displayed”
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User Interface State Machine

Indefinite dynamically loaded plug-ins

Plug-in State Machine“You’re Being Displayed”



Event-Driven Loop

Self Contained Application Framework

Plugins Need To Receive Commands

We may also want to 
broadcast messages
“Everyone STOP!”
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User Interface State Machine

Indefinite dynamically loaded plug-ins

Plug-in State Machine“Everyone STOP!”



Registering Events with Plug-in Objects
Unique events are registered for messages that will be sent to specific plug-ins

The same event can be registered with multiple plugins in order to broadcast a message
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LabVIEW API for Managing User Events

Using User Events

119

Register User Events with Listeners
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DEMO

Sending Messages to Plugins Using Dynamic Events



Abstract the Hardware in Software
Mitigate Obsolescence with a Hardware Abstraction Layer (HAL)

A plugin architecture makes it 

possible to interchange hardware 

without modifying code
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Traditional Benchtop Modular PXI Simulated (software only)
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DEMO

Hardware Abstraction Layers



Launching an actor

Launch
Actor.vi

Obtain

Actor’s Receive Queue
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Obtain
Queue

Caller’s Receive Queue



Actor.lvclass:Actor Core.vi
Responding to Message may

update Actor object.

Actor object

initial state
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MAY enqueue an asynch reply to the caller

Instance of 

Message class

Dequeue
Message

Queue

Reference

Message
.lvclass:
Do.vi



Actor Core.vi – Descendant Override

Obtain

Inside Call Parent Node
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Obtain
Queue

?

Local queued state machine, User Event loop, or
whatever you use for local behaviors.

Or “Create User Event”,
or your favorite…
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DEMO

Actor Framework



Data Communication Best Practices
Section Four
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Data Communication Options in LabVIEW

1. TCP and UDP

2. Network Streams

3. Shared Variables

4. DMAs

5. Web Services

12. Local Variables

13. Programmatic Front Panel 
Interface

14. Target-scoped FIFOs

15. Notifier

16. Simple TCP/IP Messaging 
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6. Peer-to-Peer Streaming

7. Queues

8. Dynamic Events

9. Functional Global Variables

10. RT FIFOs

11. Datasocket

16. Simple TCP/IP Messaging 
(STM)

17. AMC

18. HTTP

19. FTP

20. Global variables

… just to name a few …



Windows Real-Time FPGA

Communication Spans Processes and Targets
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DEMO

The Pitfalls of Variables



Common Pitfalls of Data Communication

Race conditions- two requests made to the same shared resource

Deadlock- two or more depended processes are waiting for each 
other to release the same resource

Data loss- gaps or discontinuities when transferring data

Performance degradation- poor processing speed due to 
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Performance degradation- poor processing speed due to 
dependencies on shared resources

Buffer overflows- writing to a buffer faster than it is read from the 
buffer

Stale data- reading the same data point more than once



The Dining Philosophers
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Message/Command

• Commander (Host) and Worker (Target) Systems

• Must be lossless* (can be buffered)

• Minimal latency

• Typically processed one at a time
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• Typically processed one at a time

• Reads are destructive

• Example: stop button, alarm, error

*some  commands may need to pre-empt other commands based on priority



Update/Monitor

• Periodic transfer of latest value

• Often used for HMIs or GUIs

• N Targets: 1 Host

• Can be lossy
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• Can be lossy

• Non-buffered

Example: monitoring current engine temperature



Stream/Buffer

• Continuous transfer, but not deterministic

• High throughput

• No data loss, buffered

• 1 Target: 1 Host; Unidirectional
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• 1 Target: 1 Host; Unidirectional

Example: High speed acquisition on target, sent to 
host PC for data logging



Variable/Tag

• Set Points and PID Constants

• Initial configuration data

• Can be updated during run-time

• Only latest value is of interest
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• Only latest value is of interest

• 1 Host: N Targets

Example: reading/writing the set-point of a thermostat, 
.ini configuration files



Choosing Transfer Types

Message Update Stream Variable (Tag)

Examples • Exec Action
• Error

• Heartbeat
• Movie

• Waveform
• Image

• Setpoint

Fundamental 

Features

• Buffering
• Blocking 
(Timeout)
• Single-Read

• Nonhistorical
• Blocking 
(Timeout)

• Buffering
• Blocking 
(Timeout)

• Nonhistorical
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• Single-Read

Optional

Features

• Ack • Broadcast • Multi-layer 
Buffering

• Dynamic Lookup
• Group Mgmt
• Latching

Performance • Low-Latency • Low-Latency • High-
Throughput

• Low-Latency
• High-Count

Configuration •N Targets: 1 Host •N Targets:1 
Host

• 1 Target:1 Host
•Unidirectional

•N Targets: 1 Host



Inter-process Communication Options
Shared Variables
Update GUI loop with latest value

Queues
Stream continuous data between loops
on a non-deterministic target

Dynamic Events
Register Dynamic Events to execute
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Dynamic Events
Register Dynamic Events to execute
sections of code

Functional Global Variables (FGV)
Use a non-reentrant subVI to protect 
critical data

RT FIFOs
Stream continuous data between time
critical loops on a single RT target 



Producer Consumer

Thread 1

Best Practices

1. One consumer per queue

2. Keep at least one reference to a 
named queue available at any time

3. Consumers can be their own 
producers
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Thread 2

Thread 3

producers

4. Do not use variables

Considerations

1. How do you stop all loops?

2. What data should the queue send?



LabVIEW FIFOs

• Queues

• RT FIFOs

• Network Streams

• DMAs
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• DMAs

• User Events

In general, FIFOs are good if you need lossless communication 
that preserves historical information



Adding Elements to the Queue

Select the data type the queue will hold

Queues

141

Dequeueing Elements

Reference to existing queue in memory

Dequeue will wait for data or time-out (defaults to -1)



Choosing Transfer Types for Inter-process

Message Update Stream Variable (Tag)

Windows • Queue
• Shared 
Variable 
(Blocking, 
Buffered)

• SE Queue
• Notifier
• Shared 
Variable
(Blocking)

• Queue
• Shared 
Variable 
(Blocking, 
Buffered)

• Local/Global
Variable

• SE Queue
• FGV
• Shared 
Variable
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Variable
• DVR

RT • Same as 
Windows

• RT FIFO

• Same as
Windows

• SE RT FIFO

• Same as 
Windows

• RT FIFO

• Same as 
Windows

FPGA • FIFO (2009) • SE FIFO 
(2009)

• FIFO • Local/Global
Variable

• FGV



RT FIFOs vs. Queues

• Queues can handle string, variant, and other variable size 
data types, while RT FIFOs can not

• RT FIFOs are pre-determined in size, queues can grow as 
elements are added to them

• Queues use blocking calls when reading/writing to a shared 

143

• Queues use blocking calls when reading/writing to a shared 
resource, RT FIFOs do not

• RT FIFOs do not handle errors, but can produce and 
propagate them

Key Takeaway: 

RT FIFOs are more deterministic for the above reasons



What is Determinism?
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Determinism: An application (or critical piece of an 
application) that runs on a hard real-time operating 
system is referred to as deterministic if its timing can 
be guaranteed within a certain margin of error.



LabVIEW Real-Time Hardware Targets

LabVIEW Real-Time
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Single-Board RIOPXI Desktop or Industrial PCCompactRIO Vision Systems



Write Data to the RT FIFO

Select the data type the RT FIFO will hold

RT FIFOs
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Read Data from the RT FIFO

Reference to existing RT FIFO in memory

Read/Write wait for data or time-out (defaults to 0)

Write can overwrite data on a timeout condition



Common Network Transfer Policies

“Latest Value” or “Network Publishing”

• Making the current value of a data item available on the 

network to one or many clients

• Examples 

– I/O variables publishing to an HMI for monitoring

– Logging temperature values on a remote PC – Logging temperature values on a remote PC 

• Values persist until over written by a new value

• Lossy – client only cares about the latest value

1-1 1-N



Latest Value Communication

API Type Performance
Ease of 

Use

Supported

Configurations

3rd Party 

APIs?

Shared 

Variable*
LabVIEW Feature 1:1, 1:N, N:1

• Measurement

Studio 

• CVI

Ref. Arch.
CCC (CVT)

Ref. Arch.

Publishes the CVT
1:1 Yes (TCP/IP)

UDP
LabVIEW Prim. 1:1, 1:N, N:1 Yes

*Network buffering should be disabled



Using Shared Variables Effectively

Programming Best Practices:

• Initialize shared variables
• Serialize shared variable execution
• Avoid reading stale shared variable data
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Common Network Transfer Policies

“Streaming”

• Sending a lossless stream of information

• Examples 

– Offloading waveform data from cRIO to remote PC for intensive processing

– Sending waveform data over the network for remote storage

• Values don’t persist (reads are destructive)• Values don’t persist (reads are destructive)

• Lossless – client must receive all of the data

• High-throughput required (latency not important)

1-1



Streaming Lossless Data

API Type Performance
Ease of 

Use

Supported

Configurations

3rd Party 

APIs?

Network Streams 

NEW!

LabVIEW 

Feature
1:1 Not this year

STM
Ref. Arch. 1:1 Yes (TCP/IP)

STM
Ref. Arch. 1:1 Yes (TCP/IP)

What about the shared variable with buffering enabled?

NO!



Pitfalls of Streaming with Variables

Machine 1 Machine 2

Server Client Readers

1 2 3 4 1 2 3 45 6 745 6 7

• Lack of flow control can 
result in data loss

• Data may be lost if the 
TCP/IP connection is 

Client Writers

1 2 3 4 1 2 3 4

5 6 7

5 6 745 6 7TCP/IP connection is 
dropped

• Data loss does not result 
in an error, only a 
warning

1 2 3 4



Network Streams NEW!

Machine A

Machine B



Network Streams in Action

Machine 1 Machine 2

Writer Endpoint Reader Endpoint

123 3 1245 12345 123 45 45 45 45 12 3456789 6789

Acknowledge (3)Acknowledge (2)Flow Control (2)

Use Streams!
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Demonstration
Inter-target Communication Using Network Streams



Common Network Transfer Policies

“Command” or “Message”

• Requesting an action from a worker

• Examples 

– Requesting an autonomous vehicle to move to a given position

– Telling a process controller to begin its recipe   

• Values don’t persist (reads are destructive)• Values don’t persist (reads are destructive)

• Lossless – client must receive every command

• Low latency – deliver the command as fast as possible

1-1 1-NN-1



Network Command Mechanisms

API Type Performance
Ease of 

Use

Supported

Configurations

3rd Party 

APIs?

Network 

Streams
LabVIEW Feature 1:1 No

Shared 
LabVIEW Feature 1:1, 1:N, N:1

• MeasurementShared 

Variable
LabVIEW Feature 1:1, 1:N, N:1

• Measurement

Studio 

• CVI

AMC 
Ref. Arch. 1:N Yes (UDP)

Web Services
Web Standard 

(New VIs in 2010)
1:1, 1:N, N:1 Yes



Writing Elements to the Stream

Reference to reader URL
Select the data type the

queue will hold

Network Streams
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Reading Elements from Stream

Reference to reader URL queue will hold

Read will wait for data or 

time-out (defaults to -1)



Network Streams

• Lossless transfer, even in connection loss*

• Can be tuned for high-throughput (streaming) 
or low-latency (messaging)

• Unidirectional, P2P, LabVIEW only
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• Not deterministic

Acquire/Control Log Data/Process
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Demonstration
Introduction to Direct Memory Access



LabVIEW 
Application

LabVIEW 
Web Service

Client
Response

Request

LabVIEW Web Services

Application Architecture:
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Sending Requests via URL:

Physical Location of Server
Name of Web Service

Mapping to a VI
Terminal Inputs (Optional)



Web Server

Web Services in LabVIEW

Windows and Real-Time
Custom web clients
No runtime engine needed
Standard http protocol
Firewall friendly
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Any Client Thin Client
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Demonstration
Basic Web Services



ni.com/uibuilder

164
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Demonstration
Thin-Client Web Interfaces



Early Access Release Details

• Anyone can evaluate for free

� Fully functional except for ‘Build and Deploy’

� License for ‘Build and Deploy’ is $1,499 per user

� License is sold as one-year software lease
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• Not part of Developer Suite or Partner Lease



Inter-Target  Communication Options
TCP/IP and UDP

Define low-level communication protocols
to optimize throughput and latency

Shared Variables

Access latest value for a network 
published variable

Network Streams
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Network Streams

Point to Point streaming in LabVIEW with high
throughput and minimal coding

Web UI Builder

Create a thin client to communicate with
a LabVIEW Web Service

DMAs

Direct memory access between to different components
of a system
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Advanced Error Handling Tools
Section Five

169



Specific Error Handling Guidelines

• Avoid allowing errors to affect subsequent code

� Not all code behaves the same in the event of an error

� Better to specifically decide which code to execute using 
case structures

• Example:

170

• Example:

� As part of shutting down your application, you need to turn 
off three values by writing false to three variables.



Specific Error Handling Example

171



Specific Error Handling Example
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Specific Error Handling Example
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Specific Error Handling Example
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Error Classification and Description

• Organizes errors into 
classifications

• Examples

� Warning

• Records additional 
information about error

• Examples

� Timestamp
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� Critical Error

� User Error

� Communications Error

� Number of Occurrences

� Variable values



Error Communication

• Transfers an errors from their origin to a central 
location

• Desirable features:

� Priority
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� Filtering (count occurrences)

� Deterministic transfer for RT applications



Error Communication Available Tools

• Custom Solutions

� Typically use queues, AMC, or priority queues

• Structured Error Handler

� Notification system provides priorities and filtering
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• Scan Engine Faults

� Provides priorities and filtering



Advanced User Interface Design
Section Six
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“Good artists borrow…
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…great artists steal.”

– Pablo Picasso



Sources of Inspiration

• Apple

• Microsoft Office

• Applications on your own computer

• Icon galleries

• Web design tutorials

• Your corporate design team
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• Photography, Art

• Books on:

� User interface design

� User interaction design

� Usability

� Graphic design

� Visualization of information



The Commandments of UI Design

• I. Help your user achieve their goal

• II. Don’t Be (too) Innovative

• III. Less Is More
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• III. Less Is More



I. Think About Your User

• Do they know as much as you (they never do)?

• How will they interact with the application?

• Why are they using your software?

� The software (and UI) should support their goal
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The software (and UI) should support their goal



II. Don’t Be Innovative

• Use familiar elements

• Don’t change expected functionality

• Polish – don’t reinvent

183

System controls  mimic common operating system controls and are familiar to most users



• Too much at once is distracting; err toward minimalism

• Stick to requirements

� Don’t do what isn’t necessary

� You’ll get done sooner

� It’ll cost you less to own it

III. Less Is More
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� It’ll cost you less to own it

• Focus should be on what’s important

� Example: Guide the user with color…



“It seems that perfection is attained not when there is nothing more to add,                 

but when there is nothing more to remove.”

– Antoine de Saint-Exupéry
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Giving your UI a Custom Look

186



UI Customization Techniques

• Make default controls transparent
• Add an image via menu Edit » Paste

Front Panel Images and Decorations

Custom Controls
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• Use to customize cosmetics of controls and indicators
• Access via front panel right-click context menu Advanced » Customize

Custom Controls

• Use to customize the functionality or cosmetics of controls and indicators
• Access via menu File » New

XControls



Adding an Image to the Front Panel

• As simple as Copy and Paste! 

• Use an image editor to erase, add transparency

• Populate native LabVIEW controls
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Start: PowerPoint Clipart



Differences in the Control Editor
N
or
m
al
 F
ro
nt
 P
an

el
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When you should use Controls

• To create cosmetically different, reusable controls

• Example: resizing a Stop button to make it easier to click

When you should use Type Defs
• To automatically update data type in custom controls
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• To automatically update data type in custom controls

• Example: reusing an Enum whose values may change

When you should use Strict Type Defs
• To create reusable controls that are identical copies 

• Example: propagating changes to Gauge size and color



Edit Mode vs. Customize Mode
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Edit Mode

• Change size or color of a 
control or indicator

• Access a right-click 
shortcut menu

Customize Mode

• Make extensive changes to 
controls or indicators

• Change individual parts of 
a control or indicator



Components of a Control (Slide)

Array 
Index

Pixel 
Increment

Housing
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Needle, Fill 
and Scale

Pixel 
Decrement

Cosmetic



Components of a Control (Gauge)

Array Index Housing
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Needle, Ramp 
and Scale

Extra Frame 
Part

Frame



Viewing Control Components

• View individual control components using menu 
Window » Show Parts Window
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DEMO

Adding a Decoration and Custom Imagery to a Gauge Control 



When you should use XControls

• To create reusable components with dynamic behavior

• To encapsulate extended functionality or cosmetics

When you should not use XControls
• To accomplish pure cosmetic changes
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• To accomplish pure cosmetic changes

• When working on a single-shot application

Use Strict Type Defs instead when…
• You do not need dynamic run-time and edit-time behavior



An XControl Example…

Design a thermometer control that can represent a single 
numeric input in either Celsius or Fahrenheit.
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Discussion: 

What makes this a good 
application for an XControl?

Note: This example XControl is pre-built as part 

of the default LabVIEW Examples



Example XControl Requirements

1. Thermometer must keep track of which temperature 
unit it represents

2. Thermometer must convert temperature between 
Fahrenheit and Celsius
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Fahrenheit and Celsius

3. Thermometer must represent a single numeric value 
and look (visually) like a thermometer.



Using XControls

• Manage XControls via the Project Explorer

• XControls appear as regular terminals

• You start with shell code
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Remember – you can go a long way without resorting to XControls

Terminal 

View

Icon

View



Structure of an XControl

Properties
(Optional)

Methods 

200

XControl Methods 
(Optional)

Abilities 
(Mandatory)



XControl Properties

• Allow the user to configure the XControl 
programmatically via Property Node
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XControl Methods

• Allow the user to engage functionality of the XControl 
programmatically via Invoke Node
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XControl Abilities

• Required components for proper function

• Represented by VIs or Controls

• Four mandatory abilities:

� Data
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Data

� State

� Façade

� Init

• Additional optional abilities may exist 



XControl Data Ability

• Type Definition Control

• Specifies the data type of the XControl
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XControl State Ability

• Type Definition Control

• Specifies information other than data type that affect 
the appearance of the XControl
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XControl Façade Ability

• Defines the appearance of the XControl

• Invoked after changes to Properties / Methods
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XControl Façade Ability

• Also invoked when:

• Data is written to the control

• Appearance needs updating

• Changing between Control and Indicator

• Shortcut menu activates
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• Shortcut menu activates

• Short menu is selected

…and more



XControl Init Ability

• Called upon first placement or load into memory

• Initializes display state before being displayed

• Handles control versioning
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DEMO

Creating a Simple XControl from Scratch



Gallery of Examples
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Credit: Simon Hogg

NI Community UI Interest Group



Gallery of Examples
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Credit: Simon Hogg

NI Community UI Interest Group



Gallery of Examples
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Credit: Jonathan Cohn – Bloomy Controls

LabVIEW Example Code Contest 2010 UI Controls Category Winner



Organization of Complex UIs

• Use when controls don’t all have to be visible at once
• Limit to the number of tabs you can gracefully use
• Loads all controls into memory at once

Tab Control
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• Loads all controls into memory at once

• Use to dynamically decide which controls to display
• No limit to the number you can gracefully interact with
• You control when the VI is loaded or release from memory

Category and Content View using SubPanels



Using a Tab Control

1. Add to front panel

2. Customize tab control

3. Populate with controls
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• More flexible than most people realize

� Transparent tabs

� Vertical tabs

� Tabs with images



Example Tab Control Application
Using LabVIEW to mimic NI DIAdem, software that outshines Excel for data postprocessing
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DEMO

Disguising a Tab Control with Transparent or Image Tabs



Using a SubPanel

1. Determine higher level VI screen real estate

2. Develop size appropriate, modular SubVIs

3. Dynamically Run SubVI

4. Dynamically insert SubVI into subpanel
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4. Dynamically insert SubVI into subpanel
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DEMO

Displaying Subpanels based upon User Selections



Gallery of Examples
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Credit: Simon Hogg

NI Community UI Interest Group



Indicating Progress of Slow Operations
• Splash screens are effective when applications have 

a long load time

� Provide development and support information

• Busy cursors
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• Progress bars

For tips on using busy cursors, view Part I of this presentation available 
on the NI Community UI Interest Group site
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DEMO

Using an Event Structure to Create a Splash Screen



Gallery of Examples

Sine Wave TesterSine Wave TesterSine Wave TesterSine Wave Tester

For Support, Please Visit: http://www.ni.com/For Support, Please Visit: http://www.ni.com/

Sine Wave TesterSine Wave Tester

For Support, Please Visit: http://www.ni.com/
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Framework Credit: Mark Ridgley, Logic PD
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